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Περιεχόμενα 12ου Μαθήματος 

 
 
 

• Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two way Analysis of 

Variance  - Two way ANOVA) 

• Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 

συνεχής - ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική 

μεταβλητή (Two way Repeated Measures Analysis of Variance - 

ANOVA) 



ΕΠΑΝΑΛΗΨΗ 

• Όταν τα δεδομένα ακολουθούν την κανονική κατανομή και έχω 
ΜΙΑ εξαρτημένη - ποσοτική μεταβλητή (π.χ. ΔΜΣ) και ΜΙΑ 
ανεξάρτητη - ποιοτική μεταβλητή (π.χ. Φύλο) που χωρίζει το 
δείγμα μου σε 2 ομάδες (άνδρες, γυναίκες), τότε το τεστ που 
χρησιμοποιώ για να βρω ΔΙΑΦΟΡΕΣ είναι το Κριτήριο t για 
Ανεξάρτητα Δείγματα (Independent samples t-test) 
 

• Όταν τα δεδομένα ΔΕΝ ακολουθούν την κανονική κατανομή και 
έχω τον ίδιο πειραματικό σχεδιασμό με το προηγούμενο 
παράδειγμα, τότε το τεστ που χρησιμοποιώ για να βρω 
ΔΙΑΦΟΡΕΣ είναι το μη παραμετρικό τεστ Mann-Whitney U 

 



ΕΠΑΝΑΛΗΨΗ 

• Όταν τα δεδομένα ακολουθούν την κανονική κατανομή και έχω 
ΜΙΑ εξαρτημένη - ποσοτική μεταβλητή (π.χ. ΔΜΣ) και ΜΙΑ 
ανεξάρτητη - ποιοτική μεταβλητή (π.χ. Πειραματική Συνθήκη) 
που χωρίζει το δείγμα μου σε πάνω από 2 ομάδες – από 3 
ομάδες και πάνω (Ομάδα Παρέμβασης 1 - πρόγραμμα 
διατροφής, Ομάδα Παρέμβασης 2 – συνδυαστικό πρόγραμμα 
άσκησης και διατροφής, Ομάδα Ελέγχου – ΔΕΝ εφάρμοσε κάποιο 
συγκεκριμένο πρόγραμμα άσκησης ή διατροφής), τότε το τεστ 
που χρησιμοποιώ για να βρω ΔΙΑΦΟΡΕΣ είναι η Ανάλυση 
Διακύμανσης Μιας Κατεύθυνσης (One way ANOVA) 

 
• Όταν τα δεδομένα ΔΕΝ ακολουθούν την κανονική κατανομή και 

έχω τον ίδιο πειραματικό σχεδιασμό με το προηγούμενο 
παράδειγμα, τότε το τεστ που χρησιμοποιώ για να βρω 
ΔΙΑΦΟΡΕΣ είναι το μη παραμετρικό Kruskal Wallis  



 

Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 
 

• Παραμετρικό test  
Πότε χρησιμοποιείται;  
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ - ποσοτική μεταβλητή  
π.χ. Δείκτης Μάζας Σώματος (BMI) &  
• ΔΥΟ ΑΝΕΞΑΡΤΗΤΕΣ – ποιοτικές μεταβλητές  
Π.χ. ΦΥΛΟ, η οποία χωρίζει το δείγμα μας σε δύο ομάδες 
     (1 = Άνδρες, 2 = Γυναίκες) &  
ΠΕΙΡΑΜΑΤΙΚΗ ΣΥΝΘΗΚΗ, η οποία χωρίζει το δείγμα μας σε 2 ομάδες  
(Ομάδα Παρέμβασης = Εφάρμοσε ένα συνδυαστικό πρόγραμμα άσκησης 
και διατροφής για 6 μήνες, Ομάδα Ελέγχου = Δεν εφάρμοσε κάποιο 
πρόγραμμα άσκησης ή διατροφής)  
 

Θέλουμε να βρούμε αν υπάρχουν ΔΙΑΦΟΡΕΣ στην ΕΞΑΡΤΗΜΕΝΗ 
μεταβλητή (π.χ. Δείκτης Μάζας Σώματος (BMI) ) λόγω της επίδρασης του 
φύλου (άνδρες, γυναίκες), λόγω της επίδρασης της Πειραματικής 
Συνθήκης (Ομάδα Παρέμβασης, Ομάδα Ελέγχου) και λόγω της 
αλληλεπίδρασης φύλου και Πειραματικής Συνθήκης 

 
 

 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου 

παράγοντα φύλου στο ΔΜΣ 
Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου παράγοντα 

φύλου στο ΔΜΣ 
 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου 

παράγοντα Πειραματική Συνθήκη στο ΔΜΣ 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου παράγοντα 

Πειραματική Συνθήκη στο ΔΜΣ 
 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική αλληλεπίδραση του φύλου και της 

Πειραματικής Συνθήκης στο ΔΜΣ  
Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχει στατιστικά σημαντική αλληλεπίδραση του φύλου και και της 

Πειραματικής Συνθήκης στο ΔΜΣ  
 



 

Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 
- 2ο Παράδειγμα 

 
• Παραμετρικό test  
Πότε χρησιμοποιείται;  
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ - ποσοτική μεταβλητή  
π.χ. Ποιότητα Ζωής &  
• ΔΥΟ ΑΝΕΞΑΡΤΗΤΕΣ - ποιοτικές μεταβλητές  
Π.χ. ΦΥΛΟ, η οποία χωρίζει το δείγμα μας σε δύο ομάδες 
     (1 = Άνδρες, 2 = Γυναίκες) &  
Τόπος Κατοικίας, η οποία χωρίζει το δείγμα μας σε τρεις ομάδες  
(1 = Πόλη, 2 = Κωμόπολη, 3 = Χωριό)  
 

Θέλουμε να βρούμε αν υπάρχουν ΔΙΑΦΟΡΕΣ στην ΕΞΑΡΤΗΜΕΝΗ 
μεταβλητή (π.χ. Ποιότητα Ζωής) λόγω της επίδρασης του φύλου 
(άνδρες, γυναίκες), λόγω της επίδρασης του τόπου κατοικίας (πόλη, 
κωμόπολη, χωριό) και λόγω της αλληλεπίδρασης φύλου και τόπου 
κατοικίας 
 

 
 

 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου 

παράγοντα φύλου στην Ποιότητα Ζωής 
Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου παράγοντα 

φύλου στην Ποιότητα Ζωής 
 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου 

παράγοντα τόπου κατοικίας στην Ποιότητα Ζωής 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχει στατιστικά σημαντική κύρια επίδραση του ανεξάρτητου παράγοντα 

τόπου κατοικίας στην Ποιότητα Ζωής 
 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική αλληλεπίδραση του φύλου και του τόπου 

κατοικίας στην Ποιότητα Ζωής 
Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχει στατιστικά σημαντική αλληλεπίδραση του φύλου και του τόπου 

κατοικίας στην Ποιότητα Ζωής 
 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 
Analyze → General Linear Model → Univariate → Παίρνω την 
εξαρτημένη μεταβλητή (Life_Quality) από αριστερά και την 
τοποθετώ δεξιά στο κουτί Dependent Variable→ Στη συνέχεια 
παίρνω τις 2 ανεξάρτητες μεταβλητές (gender & region) από 
αριστερά και την τοποθετώ δεξιά στο κουτί Fixed Factor(s) → Κλικ 
στο Options → Παίρνω από αριστερά τη gender, τη region & τη 
gender*region και τις μεταφέρω στο δεξί κουτί Display Means for & 
κλικ στο Compare main Effects → Επιλέγω ένα από τα τρια τεστ 
πολλαπλών συγκρίσεων π.χ. το LSD → Επιλέγω Descriptive Statistics 
από το Display → πατάω Continue → Επιλέγω Plots & Βάζω μια 
μεταβλητή (π.χ. region) στο Horizontal Axis & την άλλη μεταβλητή 
(π.χ. gender) στο Separate Lines και πατάω Add → Continue & OK 
 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 

Αρχικά Κλικ στο Options, περνάμε τις μεταβλητές - υποθέσεις δεξιά στο 
Display Means for, Επιλέγω Compare main effects & ένα τεστ πολλαπλών 
συγκρίσεων (post hoc π.χ. LSD), Επιλέγω Descriptive Statistics & μετά κλικ 

στο Continue 



 
Ανάλυση Διακύμανσης Διπλής Κατεύθυνσης (Two Way Anova) 

 

Κλικ στο Continue 

Κλικ στο Add 



 
Two Way ANOVA (ΧΩΡΙΣ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 

2. region 

Pairwise Comparisons

Dependent Variable:  Lif e_Quality

,192* ,085 ,033 ,017 ,367

,807* ,082 ,000 ,637 ,978

-,192* ,085 ,033 -,367 -,017

,615* ,081 ,000 ,449 ,782

-,807* ,082 ,000 -,978 -,637

-,615* ,081 ,000 -,782 -,449

(J) region

komopoli

poli

xorio

poli

xorio

komopoli

(I) region

xorio

komopoli

poli

Mean

Dif f erence

(I-J) Std.  Error Sig.
a

Lower Bound Upper Bound

95% Conf idence Interv al for

Dif f erence
a

Based on estimated marginal means

The mean dif f erence is signif icant  at the ,05 level.*. 

Adjustment f or multiple comparisons:  Least  Signif icant Dif f erence (equiv alent  to no

adjustments).

a. 

Tests of Between-Subjects Effects

Dependent Variable: Lif e_Quality

3,652a 5 ,730 21,954 ,000

557,451 1 557,451 16754,887 ,000

,046 1 ,046 1,377 ,252

3,607 2 1,803 54,200 ,000

,001 2 ,000 ,011 ,989

,799 24 ,033

570,995 30

4,451 29

Source

Corrected Model

Intercept

gender

region

gender * region

Error

Total

Corrected Total

Type II I Sum

of Squares df Mean Square F Sig.

R Squared = ,821 (Adjusted R Squared = ,783)a. 



 
Two Way ANOVA (ΧΩΡΙΣ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Descriptive Statistics

Dependent  Variable: Life_Quality

4,6640 ,07701 5

4,4775 ,09535 4

3,8500 ,07583 5

4,3200 ,37921 14

4,7425 ,10689 4

4,5450 ,13708 6

3,9417 ,34534 6

4,3681 ,41344 16

4,6989 ,09466 9

4,5180 ,12118 10

3,9000 ,25342 11

4,3457 ,39176 30

region

xorio

komopoli

poli

Total

xorio

komopoli

poli

Total

xorio

komopoli

poli

Total

gender

male

f emale

Total

Mean Std.  Dev iation N



 
Συγγραφή Αποτελέσματος Two Way ANOVA (ΧΩΡΙΣ 

ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Χρησιμοποιήθηκε Ανάλυση Διακύμανσης διπλής Κατεύθυνσης (Two Way 
Anova) για να εξεταστεί εάν υπάρχουν διαφορές στη Ποιότητα Ζωής λόγω 
φύλου, τόπου κατοικίας και αλληλεπίδρασης φύλου και κατοικίας. Τα 
αποτελέσματα έδειξαν ότι δεν υπήρχε στατιστικά σημαντική κύρια 
επίδραση του φύλου (F1,24=1.377, p=.252). Επίσης, δεν υπήρχε στατιστικά 
σημαντική αλληλεπίδραση φύλου και κατοικίας (F2,24=.011, p=.989). 
Αντίθετα, υπήρχε στατιστικά σημαντική κύρια επίδραση του παράγοντα 
τόπος κατοικίας (F2,24=54.200, p<.001). Στη συνέχεια, εφαρμόστηκε το τεστ 
Πολλαπλών Συγκρίσεων LSD για να εξεταστεί μεταξύ ποιών βαθμίδων της 
ανεξάρτητης μεταβλητής «τόπος κατοικίας» (region) υπάρχουν οι 
στατιστικά σημαντικές διαφορές. Aπό τα αποτελέσματα φαίνεται ότι οι 
κάτοικοι του χωριού (M = 4.70 ± .09) είχαν υψηλότερο σκορ στη Ποιότητα 
Ζωής σε σχέση με αυτούς που κατοικούν στην κωμόπολη (M = 4.52 ± .12) 
και την πόλη (M = 3.90 ± .25). 

 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Analyze → General Linear Model → Univariate → Παίρνω την 
εξαρτημένη μεταβλητή (score) από αριστερά και την τοποθετώ δεξιά 
στο κουτί Dependent Variable→ Στη συνέχεια παίρνω τις 2 
ανεξάρτητες μεταβλητές (sex & taxi) από αριστερά και την τοποθετώ 
δεξιά στο κουτί Fixed Factor(s) → Κλικ στο Options → Παίρνω από 
αριστερά τη sex, τη taxi & τη sex*taxi και τις μεταφέρω στο δεξί 
κουτί Display Means for & κλικ στο Compare main Effects → 
Επιλέγω ένα από τα τρια τεστ πολλαπλών συγκρίσεων π.χ. το LSD → 
Επιλέγω Descriptive Statistics από το Display → πατάω Continue → 
Επιλέγω Plots & Βάζω μια μεταβλητή (π.χ. taxi) στο Horizontal Axis & 
την άλλη μεταβλητή (π.χ. sex) στο Separate Lines και πατάω Add → 
Continue & OK  
ΠΡΟΣΟΧΗ: Αν υπάρχει αλληλεπίδραση sex*taxi, τότε θα πρέπει να 
αναλύσω την αλληλεπίδραση στο πεδίο SYNTAX 
 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 

Κλικ στο Continue Κλικ στο Plots 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 

Κλικ στο Paste 

ΓΡΑΦΩ ΤΗΝ ΕΝΤΟΛΗ 
COMPARE (taxi) ADJ (LSD) 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
ΜΑΥΡΙΖΩ ολόκληρη την 

εντολή και Κλικ στο βελάκι 
Run Current 



 
Two Way Anova (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 

Κλικ στο ΟΚ 



 
Two Way ANOVA (ME ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Tests of Between-Subjects Effects

Dependent Variable: score

28,700a 5 5,740 3,444 ,017

1116,300 1 1116,300 669,780 ,000

,300 1 ,300 ,180 ,675

12,600 2 6,300 3,780 ,037

15,800 2 7,900 4,740 ,018

40,000 24 1,667

1185,000 30

68,700 29

Source

Corrected Model

Intercept

sex

taxi

sex * taxi

Error

Total

Corrected Total

Type II I Sum

of Squares df Mean Square F Sig.

R Squared = ,418 (Adjusted R Squared = ,296)a. 

3. sex * taxi 

Univariate Tests

Dependent  Variable: score

7,600 2 3,800 2,280 ,124

40,000 24 1,667

20,800 2 10,400 6,240 ,007

40,000 24 1,667

Contrast

Error

Contrast

Error

sex

man

woman

Sum of

Squares df Mean Square F Sig.

Each F tests the simple ef fects of  taxi within each level combination of  the other ef f ects

shown. These tests are based on the linearly  independent pairwise comparisons among

the estimated marginal means.



 
Two Way ANOVA (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Pairwise Comparisons

Dependent  Variable: score

1,400 ,816 ,099 -,285 3,085

1,600 ,816 ,062 -,085 3,285

-1,400 ,816 ,099 -3,085 ,285

,200 ,816 ,809 -1,485 1,885

-1,600 ,816 ,062 -3,285 ,085

-,200 ,816 ,809 -1,885 1,485

-2,000* ,816 ,022 -3,685 -,315

,800 ,816 ,337 -,885 2,485

2,000* ,816 ,022 ,315 3,685

2,800* ,816 ,002 1,115 4,485

-,800 ,816 ,337 -2,485 ,885

-2,800* ,816 ,002 -4,485 -1,115

(J) taxi

b

c

a

c

a

b

b

c

a

c

a

b

(I) taxi

a

b

c

a

b

c

sex

man

woman

Mean

Dif f erence

(I-J) Std.  Error Sig.
a

Lower Bound Upper Bound

95% Conf idence Interv al for

Dif f erence
a

Based on estimated marginal means

The mean dif f erence is signif icant  at the ,05 lev el.*. 

Adjustment f or multiple comparisons: Least Signif icant Dif f erence (equivalent to no

adjustments).

a. 



 
Two Way ANOVA (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 

Descriptive Statistics

Dependent Variable:  score

7,00 1,000 5

5,60 ,894 5

5,40 1,140 5

6,00 1,195 15

5,80 1,304 5

7,80 1,304 5

5,00 1,871 5

6,20 1,859 15

6,40 1,265 10

6,70 1,567 10

5,20 1,476 10

6,10 1,539 30

taxi

a

b

c

Total

a

b

c

Total

a

b

c

Total

sex

man

woman

Total

Mean Std.  Dev iat ion N



 
Συγγραφή Αποτελέσματος Two Way ANOVA (ΜΕ ΑΛΛΗΛΕΠΙΔΡΑΣΗ) 

 
Χρησιμοποιήθηκε Ανάλυση Διακύμανσης διπλής Κατεύθυνσης (Two Way Anova) 
για να εξεταστεί εάν υπάρχουν διαφορές στο βαθμό των μαθηματικών (score) 
λόγω φύλου (μαθητές, μαθήτριες), τάξης (Α, Β, Γ τάξη) και αλληλεπίδρασης 
φύλου και τάξης. Τα αποτελέσματα έδειξαν ότι δεν υπήρχε στατιστικά σημαντική 
κύρια επίδραση του φύλου (F1,24=.180, p=.675). Αντίθετα, υπήρχε στατιστικά 
σημαντική κύρια επίδραση του παράγοντα τάξη (F2,24=3.780, p<.05) και 
στατιστικά σημαντική αλληλεπίδραση φύλου και τάξης (F2,24=4.740, p<.05). 
Αναλύοντας την αλληλεπίδραση ως προς την τάξη βρέθηκε ότι οι μαθητές δεν 
διέφεραν στατιστικά σημαντικά στο βαθμό των μαθηματικών (score) στις τρεις 
τάξεις (F2,24=2.280, p=.124). Αντίθετα, οι μαθήτριες διέφεραν στατιστικά 
σημαντικά στο βαθμό των μαθηματικών (score) στις τρεις τάξεις (F2,24=6.240, 
p<.01). Στη συνέχεια, εφαρμόστηκε το τεστ Πολλαπλών Συγκρίσεων LSD για να 
εξεταστεί μεταξύ ποιών βαθμίδων της ανεξάρτητης μεταβλητής «τάξη» 
υπάρχουν οι στατιστικά σημαντικές διαφορές. Aπό τα αποτελέσματα φαίνεται 
ότι οι μαθήτριες της Β τάξης (M = 6.70 ± 1.57) είχαν υψηλότερο σκορ στο βαθμό 
των μαθηματικών σε σχέση με τις μαθήτριες της Α τάξης (M = 6.40 ± 1.27) και της 
Γ τάξης (M = 5.20 ± 1.47). 

 



 
 
 
 

Περιεχόμενα 12ου Μαθήματος 

 
 
 

• Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 

συνεχής - ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική 

μεταβλητή (Two way Repeated Measures Analysis of Variance - 

ANOVA) 



ΕΠΑΝΑΛΗΨΗ 

• Όταν τα δεδομένα ακολουθούν την κανονική κατανομή και έχω 
ΜΙΑ εξαρτημένη - ποσοτική μεταβλητή (π.χ. ΔΜΣ) με 2 
μετρήσεις (αρχική, τελική), τότε το τεστ που χρησιμοποιώ για να 
βρω ΔΙΑΦΟΡΕΣ είναι το Κριτήριο t για Εξαρτημένα Δείγματα 
(Paired samples t-test) 
 

• Όταν τα δεδομένα ΔΕΝ ακολουθούν την κανονική κατανομή και 
έχω τον ίδιο πειραματικό σχεδιασμό με το προηγούμενο 
παράδειγμα, τότε το τεστ που χρησιμοποιώ για να βρω 
ΔΙΑΦΟΡΕΣ είναι το μη παραμετρικό Wilcoxon test 

 



ΕΠΑΝΑΛΗΨΗ 

• Όταν τα δεδομένα ακολουθούν την κανονική κατανομή και έχω 
ΜΙΑ εξαρτημένη - ποσοτική μεταβλητή (π.χ. ΔΜΣ) με 
περισσότερες από 2 μετρήσεις - 3 τουλάχιστον μετρήσεις και 
πάνω (αρχική, μέση και τελική μέτρηση), τότε το τεστ που 
χρησιμοποιώ για να βρω ΔΙΑΦΟΡΕΣ είναι η Ανάλυση 
Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα (One-way 
repeated measures ANOVA) 
 

• Όταν τα δεδομένα ΔΕΝ ακολουθούν την κανονική κατανομή και 
έχω τον ίδιο πειραματικό σχεδιασμό με το προηγούμενο 
παράδειγμα, τότε το τεστ που χρησιμοποιώ για να βρω 
ΔΙΑΦΟΡΕΣ είναι το Friedman test. 

 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

• Παραμετρικό test  
Πότε χρησιμοποιείται;  
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ – ποσοτική μεταβλητή  
(π.χ. Μέγιστη Πρόσληψη Οξυγόνου) με ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ 
ΜΕΤΡΗΣΕΙΣ  
Π.χ. Π.χ. Αρχική – Τελική μέτρηση &  
• ΜΙΑ ΑΝΕΞΑΡΤΗΤΗ – ποιοτική μεταβλητή (π.χ. Μέθοδος 

Προπόνησης) που χωρίζει το δείγμα σε ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ 
ΟΜΑΔΕΣ (Ομάδα 1= Συνεχόμενο τρέξιμο, Ομάδα 2= 
Διαλειμματικό τρέξιμο) 

 

Θέλουμε να βρούμε αν υπάρχει επίδραση της μεθόδου προπόνησης 
(Συνεχόμενο τρέξιμο, Διαλειμματικό τρέξιμο) και της μέτρησης 
(αρχική, τελική) στην ΕΞΑΡΤΗΜΕΝΗ μεταβλητή (Μέγιστη Πρόσληψη 
Οξυγόνου) 

 
 

 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στη Μέγιστη 

Πρόσληψη Οξυγόνου μεταξύ των δύο μεθόδων προπόνησης  
Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχει στατιστικά σημαντική διαφορά στη Μέγιστη 

Πρόσληψη Οξυγόνου μεταξύ των δύο μεθόδων προπόνησης  
 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στη Μέγιστη 

Πρόσληψη Οξυγόνου μεταξύ αρχικής και τελικής μέτρησης 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχει υπάρχει στατιστικά σημαντική διαφορά στη Μέγιστη 

Πρόσληψη Οξυγόνου μεταξύ αρχικής και τελικής μέτρησης 
 
 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στη 

Μέγιστη Πρόσληψη Οξυγόνου μεταξύ των μετρήσεων (αρχική, 
τελική) και των μεθόδων προπόνησης (Συνεχόμενο τρέξιμο, 
Διαλειμματικό τρέξιμο)  

Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στη Μέγιστη 

Πρόσληψη Οξυγόνου μεταξύ των μετρήσεων (αρχική, τελική) και 
των μεθόδων προπόνησης (Συνεχόμενο τρέξιμο, Διαλειμματικό 
τρέξιμο)  

 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

• Παραμετρικό test  
Πότε χρησιμοποιείται;  
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ – ποσοτική μεταβλητή  
(π.χ. ΔΜΣ) με ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ ΜΕΤΡΗΣΕΙΣ  
Π.χ. Π.χ. Αρχική - Τελική μέτρηση &  
• ΜΙΑ ΑΝΕΞΑΡΤΗΤΗ – ποιοτική μεταβλητή (π.χ. Πειραματική 

Συνθήκη) που χωρίζει το δείγμα σε ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ ΟΜΑΔΕΣ 
(Ομάδα 1= Άσκηση, Ομάδα 2= Διατροφή, Ομάδα 3 = Συνδυασμό 
Άσκησης & Διατροφής & Ομάδα 4 = Ελέγχου - δεν ακολούθησε 
κάποιο πρόγραμμα άσκησης ή διατροφής) 

 

Θέλουμε να βρούμε αν υπάρχει επίδραση της Πειραματικής 
Συνθήκης (Άσκηση, Διατροφή, Συνδυασμός Άσκησης & Διατροφής, 
Ελέγχου) και της μέτρησης (αρχική, τελική) στην ΕΞΑΡΤΗΜΕΝΗ 
μεταβλητή (ΔΜΣ) 

 
 

 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στο ΔΜΣ μεταξύ 

των 4 πειραματικών συνθηκών (1= Άσκηση, 2= Διατροφή, 3 = 
Συνδυασμός άσκησης & διατροφής, 4 = Ελέγχου) 

Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχει στατιστικά σημαντική διαφορά στο ΔΜΣ μεταξύ των 4 

πειραματικών συνθηκών (1= Άσκηση, 2= Διατροφή, 3 = 
Συνδυασμός άσκησης & διατροφής, 4 = Ελέγχου) 

 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στο ΔΜΣ μεταξύ 

αρχικής (pre) και τελικής μέτρησης (post) 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχει στατιστικά σημαντική διαφορά στο ΔΜΣ μεταξύ 

αρχικής (pre) και τελικής μέτρησης (post) 
 
 
 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στο 

ΔΜΣ μεταξύ των μετρήσεων (αρχική, τελική) και των 
πειραματικών συνθηκών (1= Άσκηση, 2= Διατροφή, 3 = 
Συνδυασμός άσκησης & διατροφής, 4 = Ελέγχου) 

Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στο ΔΜΣ 

μεταξύ των μετρήσεων (αρχική, τελική) και των πειραματικών 
συνθηκών (1= Άσκηση, 2= Διατροφή, 3 = Συνδυασμός 
άσκησης & διατροφής, 4 = Ελέγχου) 

 
 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

• Παραμετρικό test  
Πότε χρησιμοποιείται;  
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ – ποσοτική μεταβλητή  
(π.χ. Κατακόρυφη Αλτική Ικανότητα) με ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ 
ΜΕΤΡΗΣΕΙΣ  
Π.χ. Π.χ. Αρχική - Τελική μέτρηση &  
• ΜΙΑ ΑΝΕΞΑΡΤΗΤΗ – ποιοτική μεταβλητή (π.χ. Μέθοδοι 

Προπόνησης) που χωρίζει το δείγμα σε ΔΥΟ ή ΠΕΡΙΣΣΟΤΕΡΕΣ 
ΟΜΑΔΕΣ (Ομάδα 1= Πλειομετρική προπόνηση - Άλματα, Ομάδα 
2= Προπόνηση με βάρη) 

Θέλουμε να βρούμε αν υπάρχει επίδραση της Μεθόδου 
Προπόνησης (Πλειομετρική - Άλματα, Βάρη) και της μέτρησης 
(αρχική, τελική) στην ΕΞΑΡΤΗΜΕΝΗ μεταβλητή (Κατακόρυφη Αλτική 
Ικανότητα) 

 
 

 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στην Κατακόρυφη 

Αλτική Ικανότητα μεταξύ των δύο μεθόδων προπόνησης (1= 
Πλειομετρική, 2= βάρη) 

Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχει στατιστικά σημαντική διαφορά στην Κατακόρυφη 

Αλτική Ικανότητα μεταξύ των δύο μεθόδων προπόνησης (1= 
Πλειομετρική, 2= βάρη) 

 
Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική διαφορά στην Κατακόρυφη 

Αλτική Ικανότητα μεταξύ αρχικής (pre) και τελικής μέτρησης (post) 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχει στατιστικά σημαντική διαφορά στην Κατακόρυφη 

Αλτική Ικανότητα μεταξύ αρχικής (pre) και τελικής μέτρησης (post) 
 
 
 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στην 

Κατακόρυφη Αλτική Ικανότητα μεταξύ των μετρήσεων 
(αρχική, τελική) και των μεθόδων προπόνησης (Πλειομετρική, 
βάρη)  

Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχει στατιστικά σημαντική αλληλεπίδραση στην 

Κατακόρυφη Αλτική Ικανότητα μεταξύ των μετρήσεων 
(αρχική, τελική) και των μεθόδων προπόνησης (Πλειομετρική, 
βάρη)  

 
 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

• Analyze → General Linear Model → Repeated Measures… → Στο Within-
Subject Factor Name δίνω όνομα στη μεταβλητή (π.χ. metrisi) → Στο Number 
of Levels βάζω τον αριθμό των βαθμίδων – μετρήσεων της μεταβλητής (π.χ. 2) 
→ Κλικ στο Add και μετά στο Define → Παίρνω ταυτόχρονα τις δύο βαθμίδες - 
μετρήσεις (pre, post) της εξαρτημένης μεταβλητής (metrisi) από αριστερά και 
τις τοποθετώ δεξιά στο κουτί Within-Subject Variables (factor1) → Στο 
Between-Subjects Factor(s) βάζω τον ανεξάρτητο παράγοντα (π.χ. training) → 
Κλικ στο Options → Παίρνω τις τρεις μεταβλητές (training, metrisi, 
training*metrisi) από αριστερά και τις τοποθετώ δεξιά στο κουτί Display 
Means for → Κλικ στο Compare main effects → Επιλέγω LSD & Descriptive 
statistics → πατάω Continue → Κλικ στο Plots → Παίρνω την εξαρτημένη 
μεταβλητή (metrisi) από αριστερά και την τοποθετώ δεξιά στο κουτί Horizontal 
Axis → Παίρνω τον ανεξάρτητο παράγοντα (π.χ. training) από αριστερά και 
την τοποθετώ δεξιά στο κουτί Separate Lines → Κλικ στο Add → Continue & OK  

• ΠΡΟΣΟΧΗ: Αν υπάρχει αλληλεπίδραση training*metrisi, τότε θα πρέπει να 
αναλύσω την αλληλεπίδραση στο πεδίο SYNTAX  



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

 
 

Κλικ στο Define 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

 
 

Κλικ στο Options Κλικ στο Continue 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 
συνεχής - ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική 

μεταβλητή (Two way Repeated Measures ANOVA) 

 
 

Κλικ στο Plots Κλικ στο Continue Κλικ στο OK 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

ΥΠΑΡΧΕΙ ΑΛΛΗΛΕΠΙΔΡΑΣΗ ΤΩΝ ΔΥΟ ΠΑΡΑΓΟΝΤΩΝ. ΑΡΑ ΠΡΕΠΕΙ ΝΑ 
ΑΝΑΛΥΣΟΥΜΕ ΤΗΝ ΑΛΛΗΛΕΠΙΔΡΑΣΗ ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΤΟ SYNTAX 

Tests of Within-Subjects Effects

Measure: MEASURE_1

185,020 1 185,020 105,866 ,000

185,020 1,000 185,020 105,866 ,000

185,020 1,000 185,020 105,866 ,000

185,020 1,000 185,020 105,866 ,000

106,667 1 106,667 61,033 ,000

106,667 1,000 106,667 61,033 ,000

106,667 1,000 106,667 61,033 ,000

106,667 1,000 106,667 61,033 ,000

26,215 15 1,748

26,215 15,000 1,748

26,215 15,000 1,748

26,215 15,000 1,748

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Source

metrisi

metrisi * training

Error(metrisi)

Type II I Sum

of Squares df Mean Square F Sig.



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Κλικ στο Paste Μαυρίζω ΟΛΗ την εντολή 
& πατάω το βελάκι Run 

Γράφω COMPARE (metrisi) ADJ (LSD) 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

3. training * metrisi 

Multivariate Tests

,162 2,897a 1,000 15,000 ,109

,838 2,897a 1,000 15,000 ,109

,193 2,897a 1,000 15,000 ,109

,193 2,897a 1,000 15,000 ,109

,921 174,072a 1,000 15,000 ,000

,079 174,072a 1,000 15,000 ,000

11,605 174,072a 1,000 15,000 ,000

11,605 174,072a 1,000 15,000 ,000

Pillai's trace

Wilks' lambda

Hotelling's trace

Roy 's largest root

Pillai's trace

Wilks' lambda

Hotelling's trace

Roy 's largest root

training

vari

jump

Value F Hypothesis df Error df Sig.

Each F tests the multivariate simple ef fects of  metrisi within each level combination of  the other

ef f ects shown. These tests are based on the linearly  independent pairwise comparisons among

the estimated marginal means.

Exact statist ica. 

Descriptive Statistics

47,12 3,720 8

47,00 4,822 9

47,06 4,205 17

48,25 4,062 8

55,22 3,528 9

51,94 5,129 17

training

vari

jump

Total

vari

jump

Total

pre

post

Mean Std. Dev iat ion N



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

3. training * metrisi 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Εφαρμόστηκε Ανάλυση Διακύμανσης με 1 επαναλαμβανόμενο παράγοντα & 1 
ανεξάρτητο παράγοντα (Two way Repeated Measures ANOVA) για να εξεταστεί 
εάν υπάρχουν διαφορές στην Κατακόρυφη Αλτική Ικανότητα μεταξύ των 
μετρήσεων (αρχική, τελική) και των μεθόδων προπόνησης (Πλειομετρική, βάρη). 
Από τα αποτελέσματα φαίνεται ότι υπάρχει στατιστικά σημαντική αλληλεπίδραση 
μεταξύ των μετρήσεων και των μεθόδων προπόνησης (F1,15 = 61.033, p < .001). 
Αναλύοντας την αλληλεπίδραση ως προς την μέτρηση (metrisi) βρέθηκε ότι οι δεν 
υπήρχαν στατιστικά σημαντικές διαφορές στην Κατακόρυφη Αλτική Ικανότητα 
μεταξύ αρχικής (pre) και τελικής (post) στην ομάδα των αθλητών που έκανε 
προπόνηση με βάρη (F1,15 = 2.897, p = .109). Αντίθετα, βρέθηκαν στατιστικά 
σημαντικές διαφορές στην Κατακόρυφη Αλτική Ικανότητα μεταξύ αρχικής (pre) και 
τελικής (post) στην ομάδα των αθλητών που έκανε πλειομετρική προπόνηση (F1,15 
= 174.072, p < .001). Εξετάζοντας τους μέσους όρους, φαίνεται ότι οι αθλητές 
είχαν υψηλότερο σκορ στην Κατακόρυφη Αλτική Ικανότητα μετά την εφαρμογή του 
προγράμματος πλειομετρικής προπόνησης (M = 55.22 ± 3.53) σε σχέση με την 
αρχική μέτρηση (M = 47 ± 4.82).    



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Tests of Within-Subjects Effects

Measure: MEASURE_1

39,200 1 39,200 19,510 ,000

39,200 1,000 39,200 19,510 ,000

39,200 1,000 39,200 19,510 ,000

39,200 1,000 39,200 19,510 ,000

,450 1 ,450 ,224 ,639

,450 1,000 ,450 ,224 ,639

,450 1,000 ,450 ,224 ,639

,450 1,000 ,450 ,224 ,639

76,350 38 2,009

76,350 38,000 2,009

76,350 38,000 2,009

76,350 38,000 2,009

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Sphericity  Assumed

Greenhouse-Geisser

Huynh-Feldt

Lower-bound

Source

metrisi

metrisi * group

Error(metrisi)

Type II I Sum

of Squares df Mean Square F Sig.

Descriptive Statistics

3,6500 1,89945 20

3,5000 1,76218 20

3,5750 1,81005 40

5,2000 1,47256 20

4,7500 1,83174 20

4,9750 1,65618 40

group

control

experimental

Total

control

experimental

Total

score_pre

score_post

Mean Std.  Dev iat ion N

Εδώ ΔΕΝ υπάρχει 
ΑΛΛΗΛΕΠΙΔΡΑΣΗ 



Ανάλυση Διακύμανσης Επαναλαμβανόμενων Μετρήσεων με 1 συνεχής - 
ποσοτική μεταβλητή & 1 ανεξάρτητη - ποιοτική μεταβλητή (Two way 

Repeated Measures ANOVA) 

Όταν ΔΕΝ υπάρχει ΑΛΛΗΛΕΠΙΔΡΑΣΗ, γράφουμε το εξής:  
Εφαρμόστηκε Ανάλυση Διακύμανσης με 1 επαναλαμβανόμενο παράγοντα 
& 1 ανεξάρτητο παράγοντα (Two way Repeated Measures ANOVA) για να 
εξεταστεί εάν υπάρχουν διαφορές στην Ποιότητα Ζωής (metrisi) μεταξύ 
των μετρήσεων (score_pre, score_post) και των ομάδων παρέμβασης (1 = 
control, 2 = Experimental). Από τα αποτελέσματα φαίνεται ότι δεν υπάρχει 
στατιστικά σημαντική αλληλεπίδραση μεταξύ των μετρήσεων και των 
ομάδων παρέμβασης (F1,38 = .224, p = .639). Αντίθετα, βρέθηκαν στατιστικά 
σημαντικές διαφορές στην Ποιότητα Ζωής (metrisi) μεταξύ αρχικής και 
τελικής μέτρησης (F1,38 = 19.510, p < .001). Εξετάζοντας τους μέσους όρους 
φαίνεται ότι οι συμμετέχοντες είχαν υψηλότερο σκορ στην Ποιότητα Ζωής 
στην τελική μέτρηση (M = 4.98 ± 1.66) σε σχέση με την αρχική μέτρηση (M = 

3.58 ± 1.81).  
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